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PACKAGE CONTENTS \

Check that the package contains the following items before
using the label printer. If any item is missing or damaged,
please contact us.

_____ o

e } p ,;\‘:xf
Label Printer Fan-fold Labels User Manual

@ O = =

Power Adapter USB Cable  USBDrive  USB Type-C
Adapter

» Note

Installation drivers and setup guides for Windows/MacOS
can be downloaded from the Jiose official website or found
on the provided Jiose USB drive.




MACHINE COMPONENTS \

- Inner View Printer Head
Mechanism

Rubber Roller )
Paper Feeding

Guide Rail

» How-to Open:

Press the both Push Buttons on the side at the same time to
open the printer.

- Rear View
Feed Button Paper Feeding
Guide Rail
USB Port

Push Button

Power Port

Power Button



PRINTER CONNECTION \
» Warning
Make sure the printer is OFF (O=OFF)
before plugging in the power cable.

OFF Otherwise, it will affect the service life.

e —
1. Ensure the printer poweris 2. Connect the power cable
OFF (O:O FF) (Make sure your adapter is connected

to the power cable tightly.)

s

;

I —

3. Connect the USB cable 4. Turn the power ON (I=ON)

(If your computer has only Type-C
interface, please use a Type-C USB
cable or USB-C to USB Adapter.)



LED LIGHT INDICATOR \

Light Description Troubleshoot
Solid Blue Normal operation
: ; The printer job will
Printer head is .

i tself aft
Flashing Blue overheated E:eo?lirrr:ge.l self after
Flashing Red Reload label to
(once per Paper shortage check if label is
second) loaded correctly.
Flashing Red .

(twice every Lid is not closed Close the lid properly.
second)

Solid Purple Firmware upgrade Restart the printer to
(or white) mode restore normal.

Flashing Purple
(or White) with
beeps

Wrong power
adapter

Use original power
adapter or contact
customer service.




LABEL SETUP \

Label Standard Size

L] [ ]
37X1"” 27X1"
3”X2" 2nx2n

3"X3”

47X4"

4"X6"

1. Automatic Label Identification
(Load label without opening the printer)

(1 Connect the printer to the power and turn it on.

(2) Adjust the guide rail (refer to picture a).

(3 Insert the label deeply and straightly along the guide rail with no
gaps or deviations (refer to picture b).

(@) Once the printer detects the label, it will automatically catch the
label and roll it back and forth. When finished, the label will be
positioned at the tear-off point.




LABEL SETUP ‘

2. Run the Intelligent Label Study
(D After the Automatic Label Identification, press the Feed Button
until you hear one beep, then release it (refer to picture c)

@ The printer will move the label back and forth at the previous 2
joints of the label, to study the label size, thickness, and gap size of
your label (refer to picture d).

(3 After studying the label, the printer will be positioned at the tear-off
point so that not a single sheet of paper is wasted.

@ Then the printing can begin.

, N
o X

Eokl

» Note

When loading the printer with labels of different sizes, please run the
Intelligent Label Study process before printing.




FEED BUTTON MODE \

Desired Action

Execution

Run the Intelligent
Label Study

Insert label, press and hold the Feed Button
until hearing one "beep" sound.

Print a technical

Load the paper, press and hold the Feed
Button until you hear a sequence of two

test page beep sounds (one short "beep" followed by
"beep beep").
Press and hold the Feed Button until you
Restore'factory hear three beep sounds. (a single "beep”,
setting followed by "beep beep", and concluding
with "beep beep beep")
Skip a label One Click the Feed Button while the printer

is on standby. (i.e. nothing is being printed)

Pause printing

One Click the Feed Button while printing
many sheets.

Resume printing

One Click the Feed Button again to resume
printing from a pause.

- 07 —




DRIVER INSTALLATION
FOR MACOS & WINDOWS
Thermal Label Printer Driver Installation for Windows

The following is a picture example of the installation steps of the thermal
printer J500/J5008T.

. Insert the USB drive that came with the package to computer.

Il. Open the Windows Driver folder to get the driver file and install it with
the following steps (or visit website: www.jioseprinter.com to get it).

|} 01-Windows Setup

[7] 02-MacOS Setup ‘

|} 03-Setup Video

51 Jiose Customer Service Cardjpg

i Jiose Printer FAQ

Shipping Label Cut & Print Guide.pdf

» Note

Make sure the label printer is connected to your computer
with the USB cable and turn it ON (I=ON) before installation.




01. Double click the Windows driver file to install it.

ﬁ\ J500 Driver Installation Guide for Windows.pdf

B 1500 Printing Setup Guide for Windows.pdf

J Jiose-Windows-Driver-Latest v1.3.1.exe ‘

02. Click "Yes" to allow the installation.

J Jiose Printer Driver Setup

LIMITED
File origin: Hard drive on this computer

Show more details

Verified publisher: HONGKONG JIAHE INTERNATIONAL HOLDING

—

;

J Setup - Jiose-Windows-Driver-Latest v1.3.2
Ready to Install

your computer.

Setup is now ready to begin instaling Jose-Windows-Driver-Latest v1.3.2 on

Click Install to continue with the nstalation.

Engish

Get help




03. Then, it will show as below, (The Port should be automatically filled out
by USB001 or USB002, USB003,...). Click the "Install Driver Now" as the
arrow pointed.

Printer Model: ~ Jiose J500 ~

Driver Name:  Jiose J500 8 Default Printer

Detect USB Port

Port:

Tips: if program can't find
button to get current USB.

Automatically filled out

Port

USBOOT Virtual printer port for USB
USB002 Virtual printer port for USB
USB003 Virtual printer port for USB
USBOO4 Virtual printer port for USB
USBO0S Virtual printer port for USB
USBOO6 Virtual printer port for USB
USBO07 Virtual printer port for USB
USBO08 Virtual printer port for USB

Install Driver Now! Exit

Detected USB Port : USB009 ‘

04. Finally, the page will display "Add Printer Successfully!"
(Tips: If you do not see the successful dialog box, please proceed
with the following troubleshooting steps.)

Printer Model:  Jiose 500 v
Driver Name: Jiose J500(1) (@ Default Printer
Port:  USB009 Detect USB Port
Tips: if program can‘t find US Tips X tlick [Detect USB Fort]
button to get current USB pj‘ rportin the list below.
Port | Add Printer Successfully! | Type
USBOOT | printer port for USB I
USB002 printer port for USB
USB003 printer port for USB
USB004. l printer port for USB
USB00S Virtual printer port for USB
USB006 Virtual printer port for USB
USB007 Virtual printer port for USB
USB008 Virtual printer port for USB
Install Driver Now! Exit

Installing driver..




Thermal Label Printer Driver Installation for Mac

The following is a picture example of the installation steps of the thermal
printer J500/J500BT.

|. MacOS Driver installation

01. Insert the USB drive that came with the package to computer.

-

02. Open the MacOS Diriver folder to get the driver file and install it
with the following steps (or visit website: www.jioseprinter.com to get it).

| 01-Windows Setup

1 02-MacOSs Setup‘

| 03-Setup Video

Jiose Customer Service Card.jpg

#2] Jiose Printer FAQ

3] Shipping Label Cut 8 Print Guide.pdf

» Note
Before installation, make sure that the label printer is connected to

your computer with the USB cable and power on. This will allow the
driver wizard to automatically identify the printer model.




03. Double-click on the *dmg driver file to open the file.

Jiose-Mac- ‘
Driver_v1.2.4.dmg

04, It will show as below. Double-click on the *pkg file to run the
installation wizard.

f. £ J Jiose-Mac-Driver_v1.2.4
J .
Double Click
1 Read Instatlation Guide PDF 2. JiosePrinter-Driver.pkg’ to install 3 Princ Sample to test

,% ®

A
g
J500 Driver Installation JiosePrinter-Driver.pkg
Guide for MacOS.pdf Sample.pdf

Get help: www.JiosePrinter.com




» Note

It may display a message that the file
can't be opened because of security
settings. Don't worry, you just need to
perform the following steps to grant
access.

(Tips: You can skip this step if you don't see this
message or if you already know how to install a
third-party software on MacOS and prefer to do it
in your own way.)

©

“Jiose-Mac-Driver-v1.4.0.pkg"
can't be opened because it was
not downloaded from the App
Store.

Your security settings allow installation
of only apps from the App Store.

OK

- @@

@. Open "System Preferences" on Mac from the Apple menu.

@. Click the "Privacy & Security" tab as the arrow pointed. Then scoll down
to find "Security", select "APP Store and identified developers" Then try

again to install the driver.

(- ° Privacy & Security )
Q
m— App Management
B sceen ime ) Derusrer ook
&) General
(@Y [@ Analytics & improvements
Jeceas iy, @) Apple Advertising
5 control Center
@ siri & spotiight ey
Allow applications downloaded from
(B pesktop & Dock App Store
© Abp Store and Eentified developers
€3 visplays ¥
(. Wallpaper. 79y FileVault Turn Off...
@ e
[E) screen Saver il
2 sattery
WARNING: Yo
overy k
B Lock Screen your password and recovery key, the data wil be lost.
@ Touch ID & Password FileVault s turnd on for the disk *Macintosh HD".
£ Users & Groups
() Lockdomn wods Tun On...
Lockdown Mode | protection that
Passwords should only be u u may be personally

» Note

As MacOS updates its security policies periodically, if you are using
an older version of MacQOS, or encounter other difficulties, please

contact our customer service for assistance.




05. Double-click on the *.pkg file to start the installation wizard, then click
"Continue" and follow the onscreen instructions.

/. & Install JiosePrinter Ver1.2.4 ﬁ\

Welcome to the JiosePrinter Ver1.2.4 Installer

The driver files will be copied to the path: /Library/Printers/Jiose/
® Introduction

Continu
S =  _

() & Install JiosePrinter Ver1.2.4 )
Standard Install on “Macintosh HD"

Introduction This will take 101 KB of space on your computer.

Destination Select Click Install to perform a standard installation of this software
® Installation Type on the disk “Macintosh HD".

Change Install Location...

Customize Go Back Ins(all‘




06. Please grant authorization with account password, depending on your
Mac's security Settings.

a
st L
LL’E.
Introduction g
Destination Select e on of this software
o Installation Type Installe is trying to install new software.
Enter your password to allow this.
Jiose
Install Software
Cancel
Change Install Location...
Customize GoBack Install

Finally, it shows the driver is installed successfully. Please click "Close" to
finish the installation.

[ ] & Install JiosePrinter Ver1.2.4 )
Thei ion was
Introduction
Destination Select
Installation Type
Installation
. . .
SRy The installation was successful.

The software was installed.

Close

At this moment, the driver has been installed. In addition, you still need to
add the printer to your Mac.



Il. Add the Label Printer

01. Select "System Preferences" and open it.

02. Select "Printers & Scanners" as the arrow pointed, then click "Add
Printer".

(0 [ ] Printers & Scanners h
Sseacy Default printer Last Printer Used &

5 control Center
© siri & Spotlight
[ Privacy & security No Printers

Default paper size Y

Desktop & Dock Add Printer, Scanner, or Fax...  ?
€3 pisplays
\::) Wallpaper

22 Screen Saver
) Battery

g Lock Screen
) Touch ID & Password
A Users & Groups

click it to add a new printer.

(L8 Passwords
Internet Accounts
@ Game Center

(=) Keyboard
() Trackpad

@ Printers & Scanners
L— J

» Note

Before adding printer, make sure that the printer is connected to
your computer with the USB cable and turned on. This will allow
the driver wizard to automatically identify the printer model.




03. The JIOSE J500 will appear automatically, just click on it to continue.
It will show as below. (If the printer is not listed here, check if the printer

is connected to the computer and turned on.)

eoe

Add Printer \

JIOSE J500 ‘

Name:

Location:

8 ®
(al )
Name ~ Kind
uss

Add Printer

@ & @

Name

JIOSE J500

Name:

Location:

Use:

JIOSE J500

Jiose's MacBook Air

Choose a Driver... ‘
Software for this printer isn't availa le from Apple. Contact the printer's
manufacturer for the latest software.

/)

17 —



05. Then, click the "Select Software" in the "Use" drop-down box.

ﬁ ° Add Printer \
2 &

Name

JIOSE J500

Name: JIOSE J500
Location: Jiose's MacBook Air

Use v Choose a Driver.

Auto Select
Select Softwar
2
\ Other... /

06. Select the "Jiose Label Printer" and click "OK" to continue.

Add Printer

[ ] Printer Software

| Q

Q Sea [ DYMO Label Printer
Epson 24-Pin Series

Name || gpson 9-pin Series
JOSES | 1p Desiet Series

HP LaserJet Series PCL 4/5
Intellitech IntelliBar Label Printer, 2.3
Jiose Label printer

Oki 24-Pin Series

Oki 9-Pin Series

Zebra CPCL Label Printer
Zebra EPL1 Label Printer
Zebra EPL2 Label Printer

Locati
Use: Select Software... <

e e i




07. Click "Add", and the JIOSE J500 printer is added to your computer
successfully.

(ec e Add Printer N

@ ® @

Name ~ Kind

JIOSE J500

Name: JIOSE J500

Location: Jiose's MacBook Air

Use: Jiose Label printer ©

; e
S

08. Ok, the driver installation has been completed. You may now close
the window and learn how to set the parameters for your most commonly
used settings or try printing a sample shipping label.

(. L] Printers & Scanners \
Q search Default printer Last Printer Used ¢
© i & spotight Default paper size LR
() Privacy & Security
(B peskiop & Dock Pritees
€3 pisplays L JIOSE J500

idie, Lost
(. Wallpaper

) Screen Saver
& Battery

B Lock screen

@ Touch ID & Password
8 Users & Groups

Add Printer, Scanner or Fax... 7

() Passwords

(@ internet Accounts
@ Game Center

B Wallet & Apple Pay.

(L) Keyboard
() Trackpad

\& v




Printing Preferences \

This section helps Windows and Mac users effortlessly
locate the configuration options for customizing the page
size, print speed, and density (darkness) of labels.

For Mac:

Open the Print dialog box by
selecting File > Print, to access
the Darkness and Speed
options, you need to switch
from "Preview" option to "Printer
Features"

» Tips:

If the printed content is not centered enough, the
Horizontal and Vertical options can be adjusted to shift
the printed content accordingly.

For Windows:

Go to the "Control Panel" (or
“Settings” ) find "Printers and
Devices", right click on "Jiose
J500"(or other model) , select
"Printing preferences " > "Page
Setup"




BLUETOOTH INSTALLATION

Notice: This section is specific to model J500BT equipped with a Bluetooth
module and does not pertain to model J500 without the Bluetooth module.

> 1. Please search and download "FlashLabel" from App Store or Google Play.

< search 25 Q
FlashLabel
S ismen Angyin nformation = FlashLabel
r Techrokgy Co, Ltd @™ xiamen angyin Information
oeE P Technology Co., Ltd
500+
SARNGS 2l isall Downloads Rated for 3+ ©
37 4+ Z]
Fokkk i Years Old Utlities Xiamen|
What's New Version History

Verson1.35 3wago
Fix known bugs

Preview

About this app P

Flashlabel (APP) is a professional label
printing software

Tools

Ratings and reviews @
< o ]

10S Android

» Note

- Android phones need to use version Android 9.0 or above.

- For some Android devices, granting location permission is necessary to use
the app because Bluetooth is considered a part of the location permission. It
doesn't actually need the user's location information to run.




> 7. Open "FlashLabel" to run the app
and click "Allow" if the app asked
for Bluetooth permission.

10:58 97
< App Store

FlashLabel

“FlashLabel” Would Like to
Use Bluetooth

‘This app needs to acce:
Bluetooth to c
FlashLable for pri es,
texts, notes, and other functions.
Do you allow this app to access

Bluetooth permission?

Don't Allow Allow

> 3. Connect Bluetooth from the App to

pair the printer. (Notice: Be sure to
connect Bluetooth only from the APP,
not from the Android/iOS system
Bluetooth Settings.)

10:56 1 T e
< Connect device

Connectable devices

J500-DIBSEA-LE *

» Note:

When connecting to the printer via Bluetooth, Android ~  »
users may be required to input a PIN code. If prompted, e
try using "0000" (or "1234") as the code.

Bluetooth pairing request

|usually 0000 or 1234

Allow access to your contacts and call
history

CANCEL

> 4. Load the file that you want to print (PDFs, photos, and customized labels can

be printed).



ChromeOS Installation

1. Go to Chrome Web Store, search for "Flashlabel Extension".

(https://chrome.goole.com/webstore/category/extensions)

® ©® % Extensions X & ChromeWebStore-E X G Sign in—se4

c [. ] i ]

~ chrome web store

flashlabel
flashlabel extension

2. Add FlashLabel Extension to Chrome.

& chrome web store -3
Home > Extensions > FashLabel Extansion

H FlashLabel Extension
oA e A 0 | Productiviy | 1users




3. Click on the FlashLabel Extension to open the setting page
and click Add.

. 0%

*TF

& chrome web store Extensions

Home > Extensions > Flashlabel Extension -
[= e r— [
Ftane

E FlashLabel Extension T arege s

e K e Kk O | Productivty | 1users

Add FlashLabel Printer Setting Printer

“.insert printer and click Add button to enter the device list, then
Select the printer

2.0pen the file to print

3.Please do not close this web page. After closing, you
will not be able to select flashprinter.

4. After the printer is added successfully,if you close
this web page accidentally, you can reopen this web
page without adding a printer again

4. Select "Printer" (or shown as "Unknown device from Memory
Corp") and click on Connect (Remember to connect the printer
to your computer with the USB cable and power on).

CE B T ex

P e @0

“FathLabl Extsnion wans o conmect.

. @MEQ@® o forni 55098




5. You are all set now, please choose Flashlabel as destination
and print the labels you need!

SORE 4N SURGHARGE
COMIERGIAL PLUS PRICNG mou s

PRIORITY MAIL 2-DAY™

John Smith 99
1234 BARNES RD
‘CARSON NV 30000

SHIP DO NOT SHIP
To:

‘CAMPBELL CA 95009
USPS TRACKING #

888888888383888888888888

I
11 CAMPBELL AVE

DO NOT SHIP

Print

Destination

Paper size 150_4.00x6.00 inch -

Pages per sheet 1

Scale Fitto printable area -

Print using system dislog.. (0%P)

‘Open PDF In Preview

/

.

» Notes

1. Theres is no need to configure the printer when the
configuration notification pop-up after setting up since we
are using the extension to add printer to Chromebook;

2. Please open the extension page and keep the page
active when printing;
3. The Flashlabel Extension is developed for ChromeQS,
not for Chrome Browser in Windows or MacOS.

\

v




> Each time you load the printer with another label size, run the
intelligent label study to let the printer learn the label size
before printting.

> To skip a label, one-click the Feed Button while the printer is on
standby. .

> To print a technical test page, press and hold the feeder button
until you hear two short beeps. The technical page helps you
determine if the printer is working properly.

> Avoid poor quality labels as they may damage the printer.
> Regularly clean the printer head.

> If label is jammed, turn off the printer, unplug the power cable,
and allow the printer head to cool down. Open the cover and
ensure that the rubber is clean. If dirty, use alcohol wipe to
clean the head. Allow the area to dry off before turning the
printer on.

> Connect the printer to the same USB port on your computer

every time. This will avoid creating duplicate copies of the
printer in your operating system.



Method
Resolution

Max Printing Speed
Paper Width

Paper Thickness
Power Adapter
Pinting Life
Connection

Weight

Dimensions

Supported System

Operating
Environment

Storage
Environnent

Direct Thermal

203 dpi, 8 dots/mm

180 mm/s (7 inch/s)

40~110 mm (1.57"~4.3")
0.06~0.254 mm

DC 24V/2A

TPH 100 KM

USB (Optional with Bluetooth)
1.59 Ibs / 0.72 kg

176x 110x 93mm (L*W*H)

Windows/Mac OS (Print via USB cable)
iOS/Android (Print via Bluetooth)

Temperature: 0 to 45°C
Humidity: 10% ~ 80%

Temperature:-10 to 50°C
Humidity: 10% ~ 90% (Non condensing)



MAINTENANCE \

Printer Head Cleaning Steps:

1. Make sure to turn off the printer and unplug the power cable.

2. Open the cover, wait until the printer head cools down. It can be
very hot after printing.

3. Use an alcohol swap (not water) to completely clean the printer
head.

4, Wait until the alcohol has completely vaporized, then close the
cover.

5. Connect the power cable and print a test page to check if it is
clean.

SAFETY NOTICES \

1. The printer head can become very hot after printing labels. Do
not touch the printer head.

2. Do not bend the power cable excessively or place objects on
the cable.

3. Do not use the printer if you find any irregularities as these
could result in fire or electrocution.

4. Use only approved accessories and do not try to disassemble or
repair the unit by yourself.

5. Keep the printer away from water and other objects that could
penetrate the components.

6. Please unplug the printer when it is not in use for long periods
of time.



SUPPORT AND WARRANTY \

Your Jiose printer is covered by a one-year warranty.
You're welcome to visit our website: www.jioseprinter.com
to get the live support, latest driver, platform setup guide and

FAQs.
@ Jiose Email: support@jioseprinter.com

LiveChat: www.jioseprinter.com (Recommend)

& Jiose Tel: +1 281-236-7202

Service Hours: Weekdays from 9:00am to 18:00pm PST.
Scan QR Code below to CONTACT Jiose TECH SUPPORT

Directly or email support@jioseprinter.com

Jiose J500BT v4.02
— 29 —



